
Quick Start Guide





Welcome to the powerful world of Genesis Financial Technologies and the Trade 
Navigator. Since 1984 thousands of market professionals, investors, brokerage firms, 
and successful traders have relied on the products and services of Genesis Financial 
Technologies.  

This quick start guide covers the common areas of the Trade Navigator software to get 
you up and running quickly and painlessly. Here you will find quick, easy ways to get 
started with:  

Changing Symbols  Creating and Viewing a Filter  
Downloading Data Trade Console  
Quote Board  Instant Replay  
Adding to the Chart  Price Ladder  
Drawing Tools  Trading from the Chart  
Chart Templates and Pages  Trading Strategies on a Chart 
Trader’s Toolbox   Using the Help System  

For more detailed information be sure to check out Help Topics in the Help Menu in 
Trade Navigator.  

Contacting Genesis 
For technical support of the Trade Navigator software program please contact: 

Genesis Support 

Technical Support 

Email: Support@TradeNavigator.com 
Phone: 719.884.0245 
Hours: 6AM - 7PM MT 

 

 

 

Sales Support 

Email: Sales@TradeNavigator.com 
Toll-Free: 800.808.3282 
Phone: 719.884.0244 
Hours: 8AM - 5PM MT

Mailing Address 

Genesis Financial Technologies Inc 
4775 Centennial Blvd, Suite 150 
Colorado Springs, 80919

Training Support 

Email: Training@TradeNavigator.com 
Hours: 8AM - 5PM MT

Billing Support 

Email: Billing@TradeNavigator.com 
Phone: 719.884.0266 
Fax: 719.260.6113 
Hours: 8AM - 5PM MT



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Genesis Financial Technologies is dedicated to the study of speculation and 
investment techniques. All trading and investment techniques carry a risk of loss 
as well as the potential for profit.  
You need to assess with or without the help of a suitably licensed Investment 
Adviser in your country whether trading or investing suits your circumstances.  
Genesis Financial Technologies does not take into account the investment 
objectives, financial situation or particular needs of any particular individual.  
Genesis Financial Technologies or any agent of Genesis Financial Technologies 
does not give advice and are not Licensed to do so. Genesis Financial 
Technologies does not have any knowledge of the investment needs or 
objectives of individual clients or traders.  
The choice to undertake one of our Training Classes or Videos or Manuals 
means that you accept responsibility for your own trading outcomes and agree to 
test and verify any methods discussed therein before making any trading 
decision and decide whether it suits your circumstances.  
Hypothetical or simulated performance results have certain limitations. Unlike an 
actual performance record, simulated results do not represent actual trading. 
Simulated trading programs in general are also subject to the fact that they are 
designed with the benefit of hindsight. No representation is being made that any 
account will or is likely to achieve profit or losses similar to those shown. Do not 
risk any money that you can not afford to lose. It is important to remember that 
what has happened previously may never occur again at any time in the future.  
Genesis Financial Technologies or it’s staff, advisers, agents or owner shall not 
be liable in any way for any loss or damage arising from the use of this software 
or it’s contents. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Introduction to Trade Navigator  
Trade Navigator is a very powerful market analysis and trading tool. The staff 
here at Genesis is always striving to make Trade Navigator more powerful with 
advanced features, add user requested modifications and user friendly 
interfaces. Trade Navigator is designed for everyone from the user who just 
wants to look at a chart of today’s end of day data to the trader who wants to 
develop his own trading systems and use every feature in this great software.  
 
Trade Navigator Main Screen Overview  

  

  
 (1) The Menus  
 (2) The Toolbar  
 (3) The Symbol Grid  
 (4) The Chart  

 
 
The Menus allow you to access most of the main features of Trade Navigator 
with just a few clicks of the mouse.  
 

 
 
 



The Toolbars give you access to the items that you use the most with just one 
click of the mouse. The Toolbars can be customized to show only the items you 
chose.  
 

 
 
The Symbol Grid will allow you to scroll through the list to find the symbol for the 
stock, commodity or index you wish to view. The symbol grid can be used to filter 
out the securities you do not need to see or create a symbol group which 
contains only the symbols you are currently tracking.  
 
 

 
Hot-keys are keys on the keyboard that allow you to access a function with a 
single keystroke. For instance: To select a different symbol to view you can type 
the “S” key to access the symbol selector.  
 
You can find a complete list of Trade Navigator hot keys in the Help Menu under 
Charting Hot Keys and Tips.  
 
To change the symbol being viewed on a chart click on the chart and then type 
the letter S on your keyboard. This will bring up the Symbol Selector. In the 
Symbol Selector you can scroll through the symbols, select the symbol you wish 
to view and click OK.  
 



 
 
You can type the symbol in if you already know the symbol or you can use the 
search options.  
 
Symbol begins with – This option scrolls through the list as you type to take you 
to the section of the list where the first letters of the symbols match what you are 
typing. 
 
Description begins with – This option scrolls through the list as you type to take 
you to the section of the list where the first letters in the descriptions match what 
you are typing. This allows you to find the symbol that you are looking for by 
typing the first few letters of the name.  
 
Contains – This option allows you to filter for all of the symbols or descriptions 
that contain the word or letters that you type in. After typing the word or letters 
click the Find button and then only symbols or descriptions that contain what you 
have typed will appear in the list.  
 
Within – You can use this dropdown list to limit your search to just the symbols 
contained in a certain group of symbols.  
 
For more information about using the Symbol Selector see the Help Topics in the 
Help Menu. 
 

 
 
 



Data and Downloading  
 

Through Trade Navigator, Genesis offers a wide variety of commodities, stocks 
and indices data from around the world. Data types from end of day data to real 
time streaming data. Depth of Market, Commitment of Traders and Fundamental 
data. Trade Navigator makes updating your data a snap.  
 
Downloading Data  
 

 
 
To update the data in Trade Navigator or to download special files, make sure 
that you are connected to the internet, click on the blue telephone on the toolbar, 
select the option you wish to use and then just click on the Start button.  
 

 
 
End-of-Day Updating – This is the option you will use to collect the end of day 
(the complete day’s data) for the previous trading day or days and to collect the 
complete days data for the current trading day after 4:30 pm Mountain Standard 
Time.  
 
Current Session Daily Bars – This option allows you to collect a price bar that 
reflects what the market has done up to that time in the trading day.  
 
 
 
 
 
 



Quote Board Refresh – This option allows you to collect a price bar and 
intraday (tick) data that reflects what the market has done up to that time in the 
trading day for the symbols that you have in your Quote Board.  
 
Download Special File – This option should only be used when you are notified 
that there is an upgrade available or when a member of Genesis Technical 
Support gives you the name of a special file to download. You will be notified 
when upgrades are available through the News from Genesis that you will 
receive with your End-of-Day Updating from time to time.  
 
For more information about downloading see the Help Topics in the Help Menu.  
 
Quote Board  
 
The Quote Board allows you to get quotes during trading hours for the symbols 
that you have added to your Quote Board. If you subscribe to tick data through 
Genesis, clicking the Refresh button on the Quote Board will update the intraday 
data for the symbols that you have in your Quote Board as well as giving you a 
daily bar reflecting what that symbol has done up to that point in the trading day.  
 
You can view real time or streaming data in Trade Navigator for the symbols in 
your Quote Board provided you subscribe to those markets through Genesis. 
(You must have the correct Genesis data subscription to view real time data)  
 

 
 
To open the Quote Board hold down the Ctrl key and type the letter ‘Q’.  
 
 
 
 
 
 
 
 
 
 
 
 



To add symbols to the Quote Board click on the Quote Board and hit the Insert 
key on your keyboard. Then select the symbol you wish to add from the Symbol 
Selector and click OK.  
 
To update the data in your Quote Board simply be sure you are connected to the 
internet and click the Refresh button.  
 
For Quote Board refreshes and streaming data:  
New York markets are 30 minutes delayed. Chicago markets are 20 minute 
delayed.  
For more information about using the Quote Board see the Help Topics in the 
Help Menu.  
 
Real Time & Streaming Data  
Real Time and Streaming data will update the symbols in your Quote Board and 
the symbol on your active chart.  
 
 
Go to Edit and click on Program Settings, click on the Real Time tab and be 
sure that you have Genesis selected, next click on the Save button.  
 

If you do not see a Stoplight icon on your Tool Bar, go to View, click on 
Customize Toolbars and scroll through the list until you find the Stoplight icon. 
Place a checkmark next to the Stoplight and click Close.  

 

 
 

Now that you have the Stoplight icon on your Toolbar, simply click on it to start 
your streaming data. When the Stoplight icon turns green you are connected.  

 

 
 

To disconnect from streaming data, simply click the Stoplight icon again.  

 

Real time data requires that you have signed the appropriate agreement for the 
exchange that you wish to collect data from. Real time data allows you to see a 
continuous stream of data for the symbols from each exchange that you have 
signed up for as soon as the data is available.  

Streaming data provides a continuous stream of data much like real time data. 
However, streaming data is delayed 10 to 30 minutes depending on the 
exchange. 



Creating New Charts  
 

You can bring up additional charts to view more than one time period or symbol 
at the same time or as a tab, which allows you to switch quickly between charts.  
 
To create a new chart:  
Hold down the Ctrl key and type the letter N  
Select a symbol for the new chart and click the OK button  
 
Now that you have your new chart up you may want to add Studies, Indicators, 
Highlight Bars or even a Strategy to the chart.  
 
Applying Studies, Indicators or Strategies to a Chart  

Studies allow you to apply indicators and highlight bars to a chart, already set up 
in a pane the way you want them.  
 
Indicators allow you to apply a value or a formula that returns a value to a chart 
in the form of a line, a histogram or any of several other display types.  
 
Highlight bars change the color of any price bar or section of an indicator that 
meets the conditions set up for that highlight bar. Highlight bars can also be 
displayed as highlight markers which place a symbol above or below the bar or 
point where the conditions are true.  
 
(Strategies for the chart are only available in Trade Navigator Gold and Platinum)  
Strategies allow you to view the points on a chart where a mechanical trading 
strategy would place it’s trades. The trades appear on the chart as small 
triangles. By default blue triangles represent long entries and exits and red 
triangles represent short entries and exits while solid triangles represent entries 
and hollow triangles represent exits. The colors of the triangles can be changed.  
 
To apply studies, indicators, highlight bars or a strategy:  
Click on the chart to be sure that it is the active part if the screen.  
Type the letter A on your keyboard.  
 
 
 
 
 
 
 
 
 
 
 



Select the appropriate tab for the item you wish to apply (Studies, Indicators, 
Highlight Bars or Strategies).  
Scroll down the list until you find the item you wish to apply to the chart.  
 

 
 
Click on the name of the item you wish to add so that it is highlighted. Click in the 
Add button. You should now see the item applied to your chart.  
 
You can remove items from a chart by clicking on the label for that item and 
clicking the Remove button on the Chart Settings window that will appear.  
You can also rearrange items on the chart by either clicking on them and 
dragging them to a new position in the Chart Settings window or by clicking and 
dragging the label for that item on the chart it’s self.  
 
For more information about using Studies, Indicators, Highlight Bars and 
Strategies see the Help Topics in the Help Menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



The Chart Settings window is your control panel for the chart.  
 
 
If you click on the chart and then type the letter E, the Chart Settings window 
should appear.  
 
From the Chart Settings window you can:  
 
Add or Remove items on the chart  
Change the colors and settings  
Control the amount of data that gets loaded for the charts  
Modify the values of indicators  
Save a Pane as a Study which can be quickly applied to any chart  
Overlay indicators and much more.  
 

 
 
Each field that you select on the left side of the Chart Settings window will give 
you a set of options on the right side of the Chart Settings window that is 
designed to allow you to edit the settings for that field.  
 
The General Settings, Dates Axis and Trading Strategy fields will always stay the 
same.  
They allow you to control the following: 



General Settings  
Colors for the chart and background  
Default styles and thicknesses for lines, indicators, etc…  
Turning labels on and off  
Fonts for the chart  
Tips  
Splits and Rolls  

 
Dates Axis  

Bar period for the chart  
Grid lines on the chart  
The number of blank bars to show at the end of the chart  
(space after the most recent bar)  
The dates to load data for on the chart and or the amount of data to load  

 
Trading Strategy (available only in Trade Navigator Gold or Platinum)  

Adding a strategy to the chart  
Trade triangle color  
Profit Lines and Boxes  
 

The fields below the Pane 1: Price field will change as you add or remove items 
from the chart.  
 
These lower panes can be rearranged by clicking and dragging. This will change 
the order (top to bottom) that these panes appear on the chart.  
 
Selecting any field labeled Pane 1:, Pane 2:, Pane 3:, etc… allows you to change 
the scale and format settings for the pane it’s self.  
 
 



 
Selecting the Price field allows you to change the type of price display, color, 
width and symbol. It also allows you to show Up/Down highlights and True 
Range or view the Market Information for the current symbol.  
 
Selecting a field within a pane allows you to edit the values, color, overlay and 
display type of the selected item.  
 
Once you have a pane setup the way you want it you can select that pane, Pane 
2: for example, and then save it as a study by clicking on the Save Study button 
and giving it a name. You can then apply this study (pane) to any chart you wish, 
without having to set it up again. 
 
 
 
 
 
 
 
 
 
 
 



Drawing Tools  
 
 
You can choose from a wide variety of Drawing Tools or notations to add to your 
chart.  
 
To use the Drawing Tools simply click on the button for the tool you wish to use, 
then click on the area of the chart that you wish to draw on and drag the mouse 
to where you wish to end and release the mouse button. Some drawing tools 
only require a single click to draw, a few of them can be drawn using either 
method. The Dollar Difference Line for instance can be drawn to a point you 
select using the click and drag method while a single click will draw a dollar 
difference line from the point where you clicked to the most recent closing price.  
 
You will find the Drawing Toolbar located on the right side of the chart by default, 
however you can move it to a different area of the screen if you wish. You can 
also find the Drawing Tools under the Drawing menu at the top.  
 

 
 
 
 
 



Once you have drawn on the chart with a drawing tool you can edit that notation 
by clicking on the notation’s hotspot. This will bring up an Edit screen for that 
drawing tool.  
 

 
 
The hotspot for editing a Drawing Tool notation should look like this:  
 

 
 
You can reposition a drawing tool notation by finding the hotspot, usually at the 
end of the line or in the center of the notation and clicking on it and dragging.  
 
The hotspot for repositioning a Drawing Tool notation should look like this:  
 

 
 
For more information about Drawing Tools see the Help Topics in the Help Menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Templates and Pages  
 
 
Templates allow you to save the studies, indicators, highlight bars, strategies 
and some of the settings that you have set up on a chart. Once you have saved 
these settings to a template you can go back to that template with a few clicks of 
the mouse or with a single keystroke.  
 
To create a Template, set the chart up the way you want it, click on the 
Templates button on the toolbar, click <Manage chart templates>, click the 
New button, type in a name for your template and click the OK button.  
 

 
 
You can access a template by clicking on the Templates button on the toolbar 
and then clicking on the name of the template in the list of templates. If the 
template that you wish to apply is one of the first nine templates in the list you 
can simply click on the chart and then type the number that corresponds to that 
Template.  
 
To change the order of the templates in the list, click on the Templates button on 
the toolbar, click <Manage chart templates>, select the template you wish to 
move in the list and click either the Move Up or the Move Down button to move 
the Template up or down in the list.  
 
 
 
 
 
 
 



Applying Templates  
 
 
The templates allow you to apply multiple studies to a chart with just a couple of 
clicks of the mouse.  
 
To apply a Template simply click on the Templates button in the toolbar, scroll 
through the list of templates and click on the desired template.  
 

 
 
You can change the position of a template in the list of templates by:  
Clicking on the Templates button,  
Clicking <Manage chart templates>,  
Clicking and dragging template you wish to move to the position you want it to be 
in  
Then clicking the Close button.  
 
 



 
You can create your own template. Simply set up the chart the way you want it,  
Click on the Templates button,  
Select <Manage chart templates>,  
Then click the New button,  
Type in a name for your template and click OK.  
 
For more information about using Templates see the Help Topics in the Help 
Menu.  
Chart Pages allow you to save multiple charts and templates and save more of 
the settings than you can save with a single template.  
 
To create a Page, set the charts and templates up the way you want them, click 
on the Pages button on the toolbar, click <Create new chart page>, type in a 
name for your page and click the Save button.  
 
To access the Pages that you have created simply click on the Pages button on 
the toolbar and then click on the name of the page that you wish to switch to. 
 

 
 
For more information about using Pages see the Help Topics in the Help Menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Spread Charts  
 
 
You can create Spread Charts of symbols that you would like to see the 
difference between.  
 
To create a spread, click on the chart to be sure that it is the active window, then 
type Ctrl+N to bring up a new chart. Use the Symbol selector to select the first 
symbol. When you click OK on the Symbol Selector, the Settings for New Chart 
form will come up.  
 

 
 
 
 
Click the radio button next to Spread: to select spread.  
 



 
 
You can now select a <Custom> spread, a Crack Spread or a Crush Spread.  
Select the <Custom> and then click on the field that says Click here to add 
another row… Select Plus, Minus or Divide for the type of spread that you would 
like. The Symbol Selector will come back up at this point to allow you to select 
the second symbol. Select a symbol and click OK. Set the value for the 
multipliers and then click OK. You should now see your spread chart. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Trader’s Toolbox  
 
Trader’s Toolbox allows you to create and edit Symbol Groups, Criteria, 
Filters, Functions, Rules, Strategies, Strategy Baskets and Libraries.  
 
When you click on the Trader’s Toolbox button you’ll be accessing some of the 
most powerful features in Trade Navigator.  
 
Simply click on the Trader’s Toolbox button, click the tab that corresponds to 
the feature you wish to use and either click the New button to start a new one or 
select an item from the list and click the Edit button to work with an existing item.  
 

 
 

 
 
For more information about using Symbol Groups, Criteria, Filters, Functions, 
Rules, Strategies, Strategy Baskets and Libraries see the Help Topics in the Help 
Menu.  
 
 
 
 
 
 
 
 
 
 



Using and editing Filters  
 
 
Filters narrow down the list of symbols in the Symbol Grid to display only those 
symbols that currently best meet the criteria of the selected filter.  
 
To view these symbols in the Symbol Grid simply click on the dropdown arrow 
button at the top of the Symbol Grid, scroll down the list until you find the desired 
filter and click on it.  
 

 
 
To edit a filter:  
Open the Trader’s Toolbox by clicking on the Toolbox button on the toolbar.  
 
 

 
 
 
 



Select the Filters tab.  
Find the desired filter in the list of filters and double click on it.  
Select the Criteria you wish to edit.  
 
Some criteria allow you to set a range for the number of days after an event such 
as a volume spike that you are interested in seeing symbols for. By setting this 
range, only symbols which have had volume spikes that recently will show up 
with this filter.  
 

 
 
Select a criteria from the list which indicates an event such as 30% jump in 
volume then click on the Add Condition button.  
 
Set the range of days to look at by highlighting the number in the Below field and 
typing in the maximum number of days ago you want the spike to have occurred.  
 
Then highlighting the number in the Above field and typing in the minimum 
number of days ago you want the spike to have occurred.  
 
 
 
 
 
 



Other criteria allow you to set a range for percentiles that you are interested in 
seeing symbols for, such as Volume 20 days. By setting this range, only symbols 
which are within the percent range you set will show up with this filter.  
 

 
 
Select the Volume 20 days from the list and click on the Add Condition button.  
 
Set the range for the percent to look at by highlighting the number in the Below 
field and typing in the maximum risk percent to allow.  
 
Then highlighting the number in the Above field and typing in the minimum risk 
percent to allow.  
 
 
 
 
 
 
 
 
 
 
 
 



Criteria such as Close allow you to set a price range that you are interested in 
seeing symbols for. By setting this range, only symbols which are within the price 
range that you set will show up with this filter.  
 

 
 
Select Close from the list and click on the Add Condition button.  
 
Set the price range to look at by highlighting the number in the Below field and 
typing in the maximum close price to allow.  
 
Then highlighting the number in the Above field and typing in the minimum close 
price to allow.  
 
Now that you have adjusted the criteria to meet your needs, simply click on the 
Save button to save the filter with these settings or click the Save As button to 
save this as a new filter. 
 
 
 
 
 
 
 
 



Still other criteria such as 10% gap up can be set to True or False. These criteria 
allow you to view only those symbols for which a given condition is True or the 
given condition is False.  
 
Select the 10% gap up from the list, click on the Add Condition button and select 
either True or False.  
 
 
 
Creating a Filter  
 
 
To create a Filter, open the Trader’s Toolbox and click, the Filters tab and click 
the New button. The following screen will appear.  
 

 
 
Highlight an item from the list and click the Add Condition button. This will set 
the filter to look for only those symbols that meet the criteria of the item you have 
selected. If you added 30% jump in volume, only symbols that have had a recent 
30% jump in volume will show up for this Filter. If you then add Close up 3 days, 
and the symbol group Dow 30, only symbols from the Dow 30 that have had a  
30% jump in volume and have had an up close for the last 3 days will show up 
for this filter.  
 
Next click the Save button, type in a name for the filter and click the OK button.  
 



Now that you have created a filter, you can use your filter in the Symbol Grid by 
clicking the down arrow button to the right of the Show button on the Symbol 
Grid, find the Filter in the list and click on it.  
 

 
 
Now only symbols that meet all of the criteria for your Filter will show up in the 
Symbol Grid.  
 
If no symbols are displayed you may need to Recalculate Criteria by clicking on 
File in the upper left corner of the Trade Navigator screen and clicking on 
Recalculate Filter Criteria. This will take several minutes on most machines.  
 
For more information about using Filters and Criteria see the Help Topics in the 
Help Menu.  
 
 
 
 
 
 
 
 
 
 
 



Trading with Trade Navigator  
 
 
Trade Navigator allows you to practice your trading in a variety of ways and when 
you are ready to trade live accounts you can do that from Trade Navigator too.  
(Check with your broker to see if they support live trading through Genesis and 
Trade Navigator)  
 
Trade Console  
 
Trade Console allows you to create and track virtual trades or track your real 
trades.  
Trade Console is connected to a server which monitors simulated trades in real 
time. Your simulated trades are filled as soon as the price you have setup the 
trade for is hit.  
 
To place a trade in Trade Console, click on the Trade Console button on the 
toolbar.  
If this is the first time you have opened Trade Console you can fill in the Account 
Information and then click OK.  
 
Click on the Buy or the Sell button.  
 

 
 
Select the Symbol, Quantity and Order Type and then click the Submit Order 
button.  
(An active internet connection is required.)  
 
 



 
Placing a check in the Advanced Settings gives to access to options like:  
Order Cancels Order, Triggered By Order, Triggered by Condition and  
Trailing Stop  
 
The order will be placed in the working orders until it is filled. To check to see if it 
has been filled, click on the Modify Order button and click Check Status.  
 

 
 
To exit a trade in Trade Console, right-click on the trade you wish to exit from in 
Trade Console and click on Close Position.  
 

 
 
Select the Quantity and Order Type and then click the Submit Order button.  
(An active internet connection is required.)  
 



The order will be placed in the working orders until it is filled. To check to see if it 
has been filled, click on the Modify Order button and click Check Status.  
 
For more information about using Trade Tracker see the Help Topics in the Help 
Menu.  
 
 
 
Instant Replay  
 
 
Instant Replay allows you to virtually go back in time on the chart and watch the 
chart change to see how a market moved. In moments you can view how the 
market changed over days, weeks or even years. See how indicators responded 
and when strategies entered or exited trades.  
 
To use the instant replay feature click on the Instant Replay button on your 
toolbar or type Ctrl+R.  
 

 
 
Set the settings to what you wish to replay and click the Start Replay button.  
 



 
 
If you subscribe to Genesis intraday data you can view the movements of each 
bar for each day.  
 
For more information about using Instant Replay see the Help Topics in the Help 
Menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Price Ladder  
 
 
The Price Ladder allows you to watch the markets with Depth of Market and 
place real or simulated orders for trades. Watch Bid and Ask sizes as they come 
in with live streaming data.  
 

 
 
Click on the Price Ladder icon on your tool bar or in the View dropdown menu.  
 

 
 
Select the symbol you wish to use and click OK. 
 
 
 
 
 
 
 



 
 
To place Trades from the Price Ladder:  
 
Click on the settings button and place checkmarks next to the Order Bar and the 
Bid/Ask order buttons options. 
 

 



 
You should now see the Order Bar displayed at the bottom of the Price Ladder 
form.  
 

 
 
Note that the Bid and Ask buttons only show up if you have streaming data 
turned on.  
 
You can place orders by either clicking on one of the Buy or Sell buttons or by 
clicking in the Bid Size or Ask Size fields next to the price that you wish to place 
the trade at.  
 
If you set the Type: to Auto, it will automatically set the order to a Stop or a Limit 
order depending on the position of the selected price being above or below the 
current price.  
 
The color of the Order Bar at the bottom of the Price Ladder will change color 
depending on the type of account you are currently using and the type of position 
you are currently in with that account. The color will be as follows:  
 
 
 
 
 
 



GRAY = SIMULATED account (regardless of whether in a long, short, or flat 
position)  
YELLOW = LIVE account that is not currently in a position (i.e. FLAT)  
BLUE = LIVE account that is currently in a LONG position  
RED = LIVE account that is currently in a SHORT position  
 

 
 
Set up the order the way you want it on the Buy/Sell form.  
Next click on the Submit Order button.  
 
If real time streaming is on, the order is placed and filled from the real time 
stream, otherwise it is sent to a simulated trade server.  
 
If real time streaming is on, you have the option to do one-click orders or have 
them confirmed otherwise orders are ALWAYS confirmed prior to submission. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Trading from the chart  
 
 
Now you can place your real trades or simulated trades right from the chart as 
the data streams in live. This gives you a visual advantage for trading like you 
have never had before. Place orders at market or set up stops and limits.  
 

 
 
Order Bar  
 
The Order Bar allows you to place orders right from your chart with just a few 
clicks of your mouse.  
 
To bring up the Order Bar:  
 
Make sure that the symbol on your chart is a tradable symbol or change it to a 
symbol that is tradable. (continuous contracts such as 067s are not tradable) 
 
 
 
 
 
 
 



Click on the chart and type the letter E.  
 

 
 
Click on the word Trading in the column on the left.  
 
Select Trading Account under Display Trades and Orders, then click OK.  
 
The Order Bar will change color in the same way that the Price Bar’s Order Bar 
does:  
 
GRAY = SIMULATED account (regardless of whether in a long, short, or flat 
position)  
YELLOW = LIVE account that is not currently in a position (i.e. FLAT)  
BLUE = LIVE account that is currently in a LONG position  
RED = LIVE account that is currently in a SHORT position  
 



 
 
Your Order Bar should now appear on the right side of the chart.  
 
Select the Trading Account to use.  
 
You can now use the BUY Market and SELL Market buttons to place orders at 
the current market price.  
 
OR  
 
Use the Click chart to BUY and Click chart to SELL buttons to place STOP or 
LIMIT orders. Just click on the desired button and then click on the point on the 
chart where you would like to have the order placed.  
 
 



 
You can change the position of the order by clicking on it and dragging.  
 
Notice you now have the option to Cancel ALL orders and the option to 
FLATTEN.  
 
You can add exits for this order by clicking on the Add Bracket button. 
 
 
 



 
 
Setting up a Profit Target and a Stop Loss and clicking OK.  
 

 
 
You can change the Profit Target and a Stop Loss by clicking and dragging them 
on the chart just like you can with the first order.  
 
Notice the dotted lines connecting the orders. 
 
 
 
 
 



If you have real time streaming data turned on, you will notice that you have Bid 
and ask options at the bottom of the Order Bar.  
 

 
 
Placing a checkmark in the Bid/Ask Button: turns the Bid and ask Buy and Sell 
buttons on. 
 



 
 
These buttons are used in the same manner as the BUY Market and Sell Market 
buttons. 
 
 
 
 
 
 
 
 
 
 
 
 



For Gold and Platinum users.  
 
 

Back Testing Strategies  
(Trade Navigator Platinum is required for this feature)  

 
Open the Trader’s Toolbox by clicking on the Toolbox button on the toolbar at the 
top of Trade Navigator.  
Click on the Strategies tab.  
Scroll through the list of strategies until you find the strategy that you wish to 
back test and then double click on it.  
 

 
 
Click on the Inputs tab if you wish to optimize the Target Amount or the Stop 
Loss Amount.  
Click on the value field and adjust it to the desired amount by typing in the new 
amount.  
 
Place a check mark under Optimize and fill in the From, To and Step amounts if 
you wish to test a range of values. This will cause the Optimizer to come up in 
place of the Performance Report when you click Run. 
 

 
 



When you are ready to back test and view the Performance Report (or Optimizer) 
click the Run button.  
 
You can view a number of different reports from this screen such as Monthly 
History, Money Management (Money Mgt) reports or even charts of performance 
history. 
 

 
 
If you wish to view possible orders for the next bar, you can click on the Orders 
button instead of the Run button and get the Orders for Next Bar reports.  
 



 
 
Choose whether or not you currently have a position open for this trade and click 
the Ok button.  

 
 

 



Back-testing with Strategy Baskets  
 
 
The strategy basket is simple to use and edit.  
 
Open the Trader’s Toolbox by clicking on the button for it in the Toolbar.  
Select the Strategy Baskets tab.  
 

 
 
Click on the New button. 
 

 
 
 
 
Select a Strategy from the dropdown menu and a symbol or Symbol Group to 
test it on. Change any other settings you wish to change such as Period and then 
click the OK button.  



 
Selecting a Symbol Group allows you to test the strategy on every symbol in the 
group at one time.  
 

 
 
You can add another strategy (or several more strategies) to test at the in the 
same run by clicking the Add Item button and repeating the steps above. This 
allows you to run several strategies on the same symbol or group of symbols at 
the same time. 
 
 
 
 
 
 
 
 
 
 
 
 
 



When you are done setting the basket up, click on the Run button and the 
following report will be generated for you.  
 

 
 
You can view more in depth reports for an individual test by highlighting the 
desired test and clicking on the reports button or more in depth reports for all of 
the tests by clicking on the Merged Reports button.  
 
You can generate an Orders for Next Bar Report by clicking on the Orders 
button.  
 

 
 
This Next Bar Report will contain the orders for all of the Strategy items in one 
report. 
 



 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Applying a strategy to a chart.  
 
If you wish to see the trades for a Strategy on a chart, you can:  
 
Click on the chart to be sure that the chart has focus.  
Type the letter ‘A’.  
Find the strategy you wish to see on the chart and double click on it.  
 

 
 
The trades from the strategy should now appear on the chart as trade triangles.  
 

 



Using the Help System  
 
 
The Help System will help you to learn and use the Trade Navigator program. 
The Help System together with Genesis Technical Support staff will help you to 
make the most of your Trade Navigator experience.  
 
To access the Help System, go to the Help menu and click on the Help Topics.  
 

 
 
You can navigate through the Help Topics by clicking on the topics in the window 
on the left side of the screen.  
Clicking on the Index tab allows you to scroll through subjects and click on the 
subject to view the topic.  
The Search tab allows you to type in key words and search for subjects that way.  
 
Some words are highlighted in blue, these words will take you to a page that 
relates to the word that is highlighted for more information. To return to a 
previous page simply click the Back button at the top.  
 
If you need more personalized assistance please feel free to call the Genesis 
Technical Support at (719) 884-0245 or e mail us at support@genesisft.com. We 
are here to help you. 
 
 
 
 
 
 
 
 



Beginner’s Workbook  
 
Now that you have read a few of the basics lets walk through a practice chart.  
 
Exercise 1. Changing symbols.  
 

 1) Click on the chart.  
 2) Type in a new symbol, lets use $SPX.  
 3) Click Ok.  

 
You have just changed the chart to view the S&P 500 index.  
 
Exercise 2. Adding an indicator to the Price Pane.  
 

 1) Click on the chart and type the letter A on your keyboard.  
 2) Click on the Indicators tab.  
 3) Scroll through the list and select the MovingAvg.  
 4) Click the Add button.  
 5) Click on the MovingAvg label and drag it into the price pane.  

 
You have now added a moving average indicator to the price pane.  
 
Exercise 3. Adding a study to the chart.  
 

 1) Click on the chart and type the letter A on your keyboard.  
 2) Click on the Studies tab.  
 3) Select Stochastic.  
 4) Click the Add button.  

 
You have now added a Stochastic Study to your chart. 
 
Exercise 4. Drawing tools.  
 

 1) Click on the Trendline icon on the Drawing Tool, Toolbar on the right side of 
the screen.  

 2) Click and hold down the mouse button on the low for one of the bars on the 
chart.  

 3) Drag the mouse to the high of another bar on the chart.  
 
You have now placed a Trendline on the chart.  
 

 1) Click on the Templates button in the toolbar above the chart.  
 2) Click on the name of one of the templates in the list  

 
Your chart should now have changed to that template.  
We hope you have enjoyed your quick walk through using Trade Navigator. 


